
Zoning: Technical Guidance Note 1: Digitising Considerations 
 

1 

 
 
 

  

 

 

  

Zoning: Technical 
Guidance Note 1  
Digitising Considerations 

 

Prepared by: Roy Ferguson Consultancy 

Date: February 2018 



Table of Contents 
1 Introduction 3 

2 Data Availability 3 

3 Key Considerations 3 

3.1 Topology Considerations 3 

3.1.1 Polygons Should Not Overlap 3 

3.1.2 Avoid Unnecessary Sliver Polygons 4 

3.1.3 Consider Whether Separate Layers Are Needed 4 

3.1.4 Avoid Unnecessarily Complex Polygons 5 

3.2 Geometry Considerations 7 

4 Technical Advice 8 

4.1 Snapping Tolerance 8 

4.1.1 Layer-based Snapping Tolerance 8 

4.2 Difference 9 

4.3 Data Type 10 

4.4 Coordinate Reference System 10 

4.5 Attributes 10 

 

  



Zoning: Technical Guidance Note 1: Digitising Considerations 
 

3 

1 Introduction 

ZWS commissioned the development of a Polygon Divider tool in 2017. In the interests of making this 

freely available and open it is hosted in the QGIS Plugin Repository and the source code is available 

on Github1. The Polygon Divider can only be accessed via QGIS. Where this presents issues for Duty 

Bodies or Statutory Undertakers wishing to complete their zoning work, Zero Waste Scotland will carry 

out the division and share the resulting layers. 

To ensure equal access, free from licencing restrictions, this guidance has been written based on 

QGIS software. Many organisations used licenced software with ongoing costs. The steps described 

in the technical guidance notes can be replicated in other software except where the Polygon Divider 

is required. 

Technical Guidance Note 1 provides an overview of some of the key considerations when digitising 

data that is intended to be divided by the ‘Polygon Divider’ software.  It then offers some brief technical 

advice with regards to these considerations. 

The document is focussed on a small number of considerations by design. Specific queries which are 

not addressed within these Technical Guidance Notes should be raised with Zero Waste Scotland at 

litter.monitoring@zerowastescotland.org.uk.  

2 Data Availability 

Digitising data can be a time-consuming, resource intensive activity. It is therefore worthwhile 

thoroughly investigating existing data availability before committing to a large-scale digitisation project. 

3 Key Considerations 

GIS packages work on the assumption that the feature's geometry follows certain specifications. When 

the processing algorithms encounter data that does not follow the specifications, the software can 

return errors or crash. Alternatively, the operation may succeed without apparent problem but the 

result may be incorrect. The following sections will provide advice on specific data errors that can arise 

in the digitisation process. 

3.1 Topology Considerations 

Topology expresses the spatial relationships between connecting or adjacent vector features (points, 

polylines and polygons) in a GIS. Topological errors break the relationship between features, and thus 

every effort should be made to avoid such errors during the digitisation process. 

3.1.1 Polygons Should Not Overlap 

Polygons should not overlap. The reason for this rule is two-fold: overlapping polygons will result in 

erroneous area calculations (i.e. land will be counted multiple times); and the ‘Polygon Divider’ 

algorithm will divide both polygons, leading to multiple survey areas for the same piece of land. An 

example of how this would look is provided in Figure 1: 

                                                      
1 https://github.com/jonnyhuck/RFCL-PolygonDivider  

mailto:litter.monitoring@zerowastescotland.org.uk
https://github.com/jonnyhuck/RFCL-PolygonDivider


 

Figure 1: Example of the output when the plugin is run on overlapping polygons 

 

3.1.2 Avoid Unnecessary Sliver Polygons 

Unnecessary gaps (slivers) between polygons should be avoided due to the impact they have on the 

‘Polygon Divider’.  

The Polygon Divider aims to split all polygons into approximately 1,000m2 areas, with a lower 

bounding of 800m2. It is evidently not possible for it to divide a polygon to a ‘Target Area’ that is larger 

than itself (i.e. if the polygon has an area of 500m2, it clearly cannot be divided into 800m2 - 1,000m2 

sections). Likewise, if you have lots of separate adjoining polygons which are slightly larger than the 

‘Target Area’, you are likely to get more divided polygons that are larger than they would be if the input 

layer had been a single polygon (this is because the ‘Target Area’ would be increased to avoid 

offcuts). Therefore, unnecessary gaps between adjoining polygons should be avoided, as they will 

lead to an increase in offcuts and an increase in survey areas that are larger than the ‘Target Area’. 

A secondary reason for avoiding unnecessary slivers is that they will also affect the accuracy of area 

calculations across a large dataset. 

 

3.1.3 Consider Whether Separate Layers Are Needed 

Ordinarily we would advise that you use separate layers to represent different sets of geographic data.  

However, as our ultimate aim is to produce 1000m2 survey areas, it is worth considering whether by 

separating data you are creating offcuts (areas <800m2) that could be avoided.  Figures 2 & 3 illustrate 

an instance where adjacent layers are more useful as a single layer (please note this example is 

purely for illustrative purposes and may not be appropriate in practice).   
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Figure 2: Example of a layer with many small, islanded (sliver) polygons 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3: Example of a layer where combining two layers would reduce offcuts 

It is recognised that in many cases it will not be practical to combine adjacent layers, as it will affect 

your ability to accurately zone your land.  We are simply suggesting you bear it in mind, particularly if 

adding a new dataset that is likely to include lots of small islanded parcels of land that often abuts a 

larger and sufficiently related existing layer. 

 

3.1.4 Avoid Unnecessarily Complex Polygons 

It is recognised that many existing datasets will be justifiably complex. However, if digitising a new 

layer specifically for this project, it is worth considering the balance between the level of detail required 

for zoning against the benefits that come from dividing a simpler layer.   

Figures 5 to 8 illustrate the benefit of dividing a simpler layer.   



 

Figure 4: Example complex layer 

 

 

Figure 5: Example of a complex layer which has been divided 
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Figure 6: Example simple layer 

 

 

Figure 7: Example of a divided simple layer 

 

Whilst there may be good reason to keep the level of detail provided in the complex example (Figure 

5), there are areas where the use of multiple polygons will have a significant impact on the dividing 

process. This is particularly notable near the junctions of road sections 

3.2 Geometry Considerations 

Care should be taken to avoid self-intersections (bowties for example), duplicate nodes and polygons 

with less than 3 nodes. These represent three common errors that impact on the validity of the data. 



 

Figure 8: Example of a bowtie polygon. The green cross marks the point where the polygon self-
intersects 

 

4 Technical Advice 

This section details some of the digitisation options that are available in QGIS. It is primarily focusses 

on the advanced snapping options and how they can be used with respect to some of the key 

considerations detailed in Section 3. 

4.1 Snapping Tolerance 

Snapping tolerance is the distance used to search for the closest vertex and/or segment you are trying 

to connect to when digitising. A segment is a straight line formed between two vertices in a polygon or 

polyline. If you aren’t within the snapping distance, QGIS will leave the vertex where you release the 

mouse button. 

It is important, for accuracy, and for any tools that work with tolerance, that snapping tolerance is set 

prior to the commencement of digitisation. The snapping tolerance can be set at a global level (i.e. 

project-wide) and at a layer-based level (section 4.1.1). 

4.1.1 Layer-based Snapping Tolerance 

Layer-based snapping allows adjustment of snapping mode and tolerance for individual layers. The 

snapping options include ‘Current layer’, ‘All layers’ and ‘Advanced’.   

‘Advanced’ is particularly useful if you want to edit a layer and snap its vertices to another layer. Using 

advanced snapping tolerances helps avoid topographical errors such as slivers or overlapping 

polygons. 

The layer-based snapping tolerance is set via Settings > Snapping Options > Advanced from the 

‘Snapping mode’ pulldown menu (Figure 9). 
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Checking the ‘Enable topological editing’ ensures that the common boundaries are maintained 

correctly. QGIS detects shared boundaries by the features, so you only have to move a common 

vertex/segment once and it will update the neighbouring feature. 

Checking ‘Avoid intersections’ prevents you from drawing new features that overlap an existing one. It 

is very useful when digitising complex boundaries, as it requires less precision whilst still producing 

topologically correct polygons. The example below (Figure 10) illustrates how a new layer can be very 

quickly and crudely drawn, whilst remaining topologically correct. 

  

4.2 Difference 

There may be instances where the new polygon layer you are creating would sit on top of part of an 

existing layer. In this instance you should cut the new layer from the existing layer to avoid creating 

overlap. This can be achieved using the geoprocessing tool ‘Difference’ (Vector > Geoprocessing 

Tools > Difference). 

Snapping tolerances should be used when mapping the new features to avoid issues when cutting 

from the existing layer (i.e. to avoid slivers and/or fragments of land where the boundaries do not 

match). 

Figure 9: Accessing the snapping options 

Figure 10: Illustration of the 'avoid intersections' function shrinking and snapping the 
boundary of the new layer to the existing layer 



Given the potential size of the datasets, there may be instances where it is beneficial to create a layer 

just for cutting as this would allow greater visibility of exactly what is being cut. Following the cut, use 

the snapping options detailed in 4.10 and 4.11 when mapping the new area to your new layer. 

4.3 Data Type 

An aim of zoning relevant land is to allow the generation of 1,000m2 survey areas for monitoring 

purposes. In order for the ‘Polygon Divider’ to create these areas zoned land must be represented by 

polygons. Details on what to do if your data is not a polygon are provided in Technical Guidance Note 

2. 

4.4 Coordinate Reference System 

It is recommended that the Coordinate Reference System of your layers is set to British National Grid 

(ESPG:27700 – OSGB 1936). This ensures all measurements are in metres, the unit of measurement 

used by the ‘Polygon Divider’. 

4.5 Attributes 

The following attributes are required to be assigned to polygons.  Please assign the headers exactly 

as presented (example in Table 1): 

 Organisation responsible for the identified land (Header: Org); 

 Land type (Header: Land_Type); 

 Department (Header: Department); 

 Zone number classification (Header: Zone); 

 Health & safety or access issues present which prevent monitoring of the site (Header: 

H_and_S and populate with ‘Y’2);; and 

 Named health & safety or access reason (Header: Reason). 

 

Figure 11: Example attribute table REPLACE WITH UPDATED VERSION WHEN AVAILABLE 

With respect to health and safety, please note that polygons should be drawn so that only land 

affected (‘Y’) should have this attribute included.  

Custom Forms could be used to improve data consistency across newly created layers. Alternatively, 

fields could be assigned within the ‘New Shapefile Layer’ dialog box that pops up when a new layer is 

created.  

It is anticipated that the Org (and potentially Land-Type and Department) fields will be populated via 

an attributes driven process (e.g. ‘Spatial Join’). There may be some scope for attribute driven 

population of the zone field (see Technical Guidance Note 3), but it is expected that the process will 

predominantly rely on manual inputs. 

 

  

                                                      
2 Polygons should be drawn so that only land affected has this attribute included. NOTE: this does not 
refer to areas which present health & safety or access issues for the removal of litter as there is still a 
requirement for these areas to be clear or litter and refuse or to be kept clean of detritus 
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